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ATTENTION – READ THIS  F IRST!  

Warnings, Cautions, and Notes 
Where applicable, warnings, cautions, and notes are provided in this manual as follows: 

WARNING! Identifies a potential hazard that could cause injury or 
death. 

   

CAUTION! Identifies a potential hazard that could damage equipment or 
data. 

    

NOTE: Recommendations or general information that is particular to the 
presented material. 

All personnel involved with the installation, operation, or maintenance of the equipment described in this 
manual should read and understand the warnings and cautions provided below. 

CAUTION! This equipment contains devices that are extremely sensitive 
to static electricity. Therefore, extreme care should be taken when 
handling them. Normal handling precautions involve using anti-static 
protection materials and grounding straps for personnel. 

  

WARNING! High Voltage may be present in all parts of the system. 
Therefore, use caution when the electronics are removed from their 
containers for servicing. 

  

CAUTION! Operation with improper line voltage may cause serious 
damage to the equipment. Always ensure that the proper line voltage is 
used. 
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HARDWARE VARIATIONS AND COMPATIBIL ITY 

The 6205s2 Bathymetry & Side Scan System contains both standard and proprietary hardware. At times, 
EdgeTech may change the standard components due to their availability or performance improvements. 
Although the component manufacturers and their models and styles may change from unit to unit, 
replacement parts will generally be interchangeable. 

EdgeTech will make every effort to see that replacement components are interchangeable and use the 
same software drivers (if applicable). At times, however, direct replacements may not exist. EdgeTech will 
provide the necessary drivers with the replacement part when this happens. 

EdgeTech may also change certain hardware per customer requirements. Therefore, portions of this 
manual, such as parts lists and test features, are subject to change. These sections should be used for 
reference only. When changes are made that affect system operation, they will be explicitly noted. Also, 
some options and features may not be active in the customer's unit at the time of delivery. Upgrades will 
be made available when these features are implemented.  

Contact EDGETECH CUSTOMER SERVICE with any questions relating to compatibility.  
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ABOUT THIS  DOCUMENT 
We, the employees at EdgeTech, would like to thank you for purchasing a 6205s2 system. At EdgeTech, 
our policy is to provide high-quality, cost-effective products and support services that meet or exceed 
your requirements. We also strive to deliver them on time and continuously look for ways to improve 
them. We take pride in the products we manufacture and want you to be entirely satisfied with your 
equipment. 

Purpose of this Manual 
The purpose of this manual is to provide the user with information on the setup and use of EdgeTech's 
6205s2 Bathymetry & Side Scan System. Although this manual encompasses the latest operational 
features of the 6205s2, some features may be periodically upgraded. Therefore, the information in this 
manual is subject to change and should be used for reference only. 

Liability 
EdgeTech has made every effort to document the 6205s2 Bathymetry & Side Scan System. However, 
EdgeTech assumes no liability for errors or any damages resulting from the use of this manual or the 
equipment it documents. EdgeTech reserves the right to upgrade this equipment's features and make 
changes to this manual without notice at any time. 

Revision History 
REVISION DESCRIPTION DATE APPROVAL 
A Release to Production 5/26/2022 JF 
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WARRANTY STATEMENT 
All equipment manufactured by EdgeTech is warranted against defective components and workmanship 
for a period of one year after shipment. Warranty repair will be done by EdgeTech free of charge. 

Shipping costs are to be borne by the customer. Malfunction due to improper use is not covered in the 
warranty, and EdgeTech disclaims any liability for consequential damage resulting from defects in the 
equipment's performance. No product is warranted as fit for a particular purpose, and there is no 
merchantability warranty. This warranty applies only if: 

i. The items are used solely under the operating conditions and in the manner recommended in the 
seller's instruction manual, specifications, or other literature. 

ii. The items have not been misused or abused in any manner, nor have repairs been attempted 
thereon without the approval of EDGETECH CUSTOMER SERVICE. 

iii. Written notice of the failure within the warranty period is forwarded to the seller, and the 
directions received for properly identifying items returned under warranty are followed. 

iv. The return notice authorizes the seller to examine and disassemble returned products to the 
extent Seller deems necessary to ascertain the cause for failure. 

The warranties expressed herein are exclusive. There are no other warranties beyond those, either 
expressed or implied herein. The seller does not assume any other obligation or liability in connection 
with the sale or use of said products. Any product or service repaired under this warranty shall only be 
warranted for the remaining portion of the original warranty period. 

Equipment not manufactured by EdgeTech is supported only to the extent of the original manufacturer's 
warranties.  
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SOFTWARE SERVICE OVERVIEW 

EdgeTech provides software services free of charge. This software agreement does not address customer-
specified modifications or enhancements. These services may be ordered separately. Furthermore, 
EdgeTech software upgrades are meant for the sole use of EdgeTech customers. Any reproduction of 
EdgeTech-supplied software or file sharing is strictly prohibited. 

Software Updates and Enhancements 
EdgeTech customers can download new software releases with all modifications and enhancements by 
contacting EDGETECH CUSTOMER SERVICE. Major software issues, should they occur, will be reported directly 
to the customer. New software releases consist of the following: 

• Software enhancements that are not on the price list 
• Software fixes and changes 
• Product integration 
• Documentation updates to online help 
• Tests for compatibility with other modules 

Software patches consist of software that has undergone the following: 

• Minor software enhancements 
• Software fixes and changes 

EdgeTech customers are entitled to contact EDGETECH CUSTOMER SERVICE by telephone, facsimile, or e-mail 
to report a difficulty, discuss a problem, or receive advice on the best way to perform a task. When 
contacted, EDGETECH CUSTOMER SERVICE will do the following: 

• Respond within 24 hours via Telephone, Facsimile, and E-mail Support 
• Immediately attend to serious problems affecting operations 
• Attempt to find an immediate workaround  
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RETURNED MATERIAL AUTHORIZATION 
Prior to returning any equipment to EdgeTech, a Returned Material Authorization (RMA) Number must 
be obtained from CUSTOMER SERVICE.  

RMA Purpose  
The RMA Number identifies returned equipment when it arrives at our receiving dock and enables tracking 
while at our facility. Refer to the RMA number on all documentation and correspondences. 

All returned materials must be shipped prepaid. Freight collect shipments will not be accepted. All 
equipment should be adequately insured for shipping, but equipment belonging to EdgeTech must be 
insured for full value. 

If there is more than one item per consignment, include a packing with the shipment. An invoice can 
double as a packing slip only when the contents are clearly numbered and identified on the invoice. 

CAUTION! Never attempt to ship a topside unit in its SKB® case alone. 
Although rugged, these cases are not intended to be used as shipping 
containers, and the delicate internal components could be damaged. 
Shipping in this manner will void any warranties. 

 

NOTE: All shipping charges shall be the customer's responsibility, unless 
under warranty, as EdgeTech will pay for return shipping. 

   

NOTE: For International Shipments valued over $1000, the following 
Shipper's oath must be sent with the invoice.  

Shipper's Oath:  

"I, ______________________________, declare that the articles herein specified are the growth, 
produce, or manufacture of the United States; that they were exported from the 
United States from the port of _____________________, on or about _______________; that they 
are returned without having been advanced in value or improved in condition by any 
process of manufacture or any other means; and that no drawback, or allowance has 
been paid or admitted hereof." 

Signed ______________________________ 
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CUSTOMER SERVICE 
Customer service personnel at EdgeTech are always eager to hear from users of our products. Your 
feedback is welcome and is a valuable source of information that we use to improve these products. 
Therefore, we encourage you to contact EdgeTech Customer Service to offer any suggestions or to request 
technical support:  

NOTE: Have your system Serial Number available when contacting 
Customer Service. 

E-mail:  service@edgetech.com 

Mail:  4 Little Brook Road 
 West Wareham, MA 02576 

Telephone:  (508) 291-0057 

Fax: (508) 291-2491 

24-Hour Emergency  
Technical Support Line:  (508) 942-8043 

For more information, go to WWW.EDGETECH.COM. 

  

http://www.edgetech.com/
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COMPANY BACKGROUND 

EdgeTech (formerly EG&G Marine Instruments) traces its history in underwater data acquisition and 
processing back to 1966. EdgeTech has designed, developed, and manufactured products, instruments, 
and systems for the acquisition of underwater data—including marine, estuarine, and coastal 
applications—for over 50 years.  

The company has responded to the scientific, Naval, and offshore communities' needs by providing 
equipment—such as sub-bottom profilers, side-scan sonar, acoustic releases, USBL positioning systems, 
and bathymetric systems—that have become standards in the industry.  

EdgeTech has also consistently anticipated and responded to future needs through an active research and 
development program. Current efforts are focused on the application of cutting-edge CHIRP and acoustic 
technology.  
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1 .0  OVERVIEW 

The EdgeTech 6205s2 is a fully integrated swath bathymetry and dual-frequency side-scan sonar system 
that uses multiple receive elements and one discrete transmit element to produce real-time high 
resolution, side-scan imagery, and three-dimensional maps of the seafloor. The 6205s2 overcomes the 
limitations of multibeam echo sounders (MBES) and interferometric systems in shallow water using 
EdgeTech’s unique Multi-Phase Echo Sounder (MPES) Technology. This hybrid approach combines 
beamforming and phase discrimination techniques to determine each sounding along the seafloor. With 
the integration of EdgeTech’s Full Spectrum® CHIRP technology, the 6205s2 exceeds IHO SP-44, NOAA, 
and USACE specifications for feature detection and bathymetric point data uncertainty. 

EdgeTech’s MPES technology enables the 6205s2 to produce a wider and cleaner swath (over 200°) than 
current technologies, resulting in superior coverage enabling faster and safer survey completion. In 
addition, the 6205s2 concurrently rejects multipath effects, reverberation, and acoustic noise commonly 
encountered in shallow water environments. 

The 6205s2 provides simultaneous dual-frequency side scan sonar, operating at 520/850kHz, 
850/1600kHz, or 520/1600 kHz. The bathymetry operates at either 520kHz or 850kHz.  

Additionally, EdgeTech’s latest 2205 Electronics and Modular Arrays are utilized in the 6205s2, resulting 
in an extremely lightweight design required for shallow water applications and vessels of opportunity. The 
2205 electronics and arrays are mounted onto a streamlined body deployed over the bow or side or 
underneath a crewed or uncrewed survey vessel. Sonar data is transferred from the transceiver to the 
processing unit onboard via an Ethernet network interface.  

The 6205s2 system and its available integrations offer a powerful and versatile acquisition system suitable 
for many different survey applications. It includes an integrated sound velocity sensor. It interfaces with 
most third-party acquisition and processing software packages, standard DGPS/RTK GNSS systems, 
heading, motion, sound velocity profilers, and INS.  

The 6205s2 key features include: 

• Next-generation MPES technology 
• Unrivaled swath coverage in shallow water, when compared to other single head systems 
• Swath sectors of up to 200° 
• Co-registered dual-frequency side scan and single-frequency bathymetry 
• Superior multipath rejection 
• IHO SP-44 Special Order compliant 
• Equidistant and equiangular soundings output options 
• Comes with EdgeTech’s Discover Bathymetric Sonar Control Software 
• Motion tolerant side scan 
• Optional integrated OEM RTK GNSS aided INS unit 
• Optional EdgeTech 3400-OTS-based sub-bottom profiler kit that integrates sub-bottom data with 

6205s2 bathymetry and side scan data. 
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1.1 Applications 
The 6205s2 next-generation Swath Bathymetry & Side Scan Sonar has many potential applications, a few 
of which include: 

• Shallow Water Hydrographic Surveys 
• Benthic Habitat Mapping 
• Nautical Charting 
• Military Rapid Environmental Assessments (REA) 
• Route Surveys 
• Dredging Operations 
• Marine Debris Search 
• Port & Harbor Security 

1.2 6205s2 Configuration Options 
There are four configuration option choices to be made: 

• Which frequency pair is required? 
• Would you like a rack-mounted topside or a custom integrated stack interface unit? 
• Whether or not to have the OEM integrated RTK GNSS aided INS unit? 
• Would you like to have the 3400-OTS-based Sub-Bottom Profiler Kit? 

1.2.1 Frequency Options 
The 6205s2 is available in the following standard frequency configurations: 

• 520 / 850 kHz Dual Frequency Side Scan with 520 kHz Bathymetry Data 
• 520 / 850 kHz Dual Frequency Side Scan with 850 kHz Bathymetry Data 
• 520 / 1600 kHz Dual Frequency Side Scan with 520 kHz Bathymetry Data 
• 850 / 1600 kHz Dual Frequency Side Scan with 850 kHz Bathymetry Data 

1.2.2 OEM RTK GNSS Aided INS Unit 
The 6205s2 requires data from a third-party peripheral time/position/heading/motion sensor. This sensor 
can be COTS (commercial off-the-shelf). The sensor can be integrated as separate components to the 
6205s2, or it can be an OEM unit where the GNSS processor is integrated inside the rackmount topside, 
and the IMU is integrated inside the sonar head unit. 

NOTE: When the 6205s2 includes the OEM Integrated RTK GNSS aided 
INS unit, there is no need to use the RS-232 or LAN ports to receive data 
from peripheral GNSS/Heading/Motion sensors. 
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The 6205s2 is available with the following OEM RTK GNSS aided INS units: 

• SBG SYSTEMS EKINOX 3, WITH SEPTENTRIO ASTERX4 RTK GNSS KIT 

1.3 Main System Components 
The following components come standard with the 6205s2 System: 

1.3.1 6205s2 Swath Bathymetry and Side Scan Sonar Head 
The 6205s2 hydrodynamic sonar head is light, durable, and designed to be pole-mounted. The sonar 
electronics are contained inside a single housing, and two dual side scan arrays are mounted on the port 
and starboard sides of the vehicle. A sound velocity sensor is housed in the nose cone. Power/data deck 
cable and optional GNSS/INS Cable connectors are located on the top aft section of the sonar head.  The 
system is delivered in a hardened traveling case.  Further technical details on the 6205s2 Sonar Head are 
found in the  6205S2 SONAR HEAD TECHNICAL DESCRIPTION section of this manual. 

 

Figure 1-1: 6205s2- Forward-Port View 
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Figure 1-2: 6205s2 Aft-Starboard View 

1.3.2 6205S2-R Rack Mounted Topside Sonar Interface Box 
The topside sonar interface box delivers power to the sonar head and provides direct links between the 
sonar head, supporting sensors, and a topside computer.  The sonar head receives power and transmits 
and receives data via the provided deck cable. The serial and Ethernet ports act as a dry connection to the 
sonar head for all ancillary information (i.e., position, attitude, time, etc.) and data from the sonar head 
to the topside computer. BNC and TNC connectors provide connections to optional OEM/SBG devices and 
triggers. Front panel power switches control power to topside components, and indicator lights give 
information on their status.  The interface box can be mounted within a 19-inch computer rack or a 
hardened SKB® case. Technical details are found in the 6205S2 TOPSIDE SONAR INTERFACE BOX TECHNICAL 

DESCRIPTION section of this manual.  
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Figure 1-3: 6205s2 Topside Interface Box on Hardened SKB® Case 

1.3.3 Discover Software  
EdgeTech’s Discover Bathymetric Software Acquisition package provides a way to control, store, and 
display the Bathymetry and Dual Frequency Side Scan Sonar data. For more information, refer to the 

DISCOVER BATHYMETRIC SOFTWARE MANUAL. 

 

Figure 1-4: Discover Bathymetric Software 

https://www.edgetech.com/resource-center/
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1.3.4 Third-Party Software  
Several third-party topside software applications are capable of acquiring and processing Bathymetry and 
Side Scan data from EdgeTech systems. Currently, Hypack, SonarWiz, Beamworx, and Qinsy software 
packages have been approved, and work continues to expand the number of compatible topsides. CARIS 
HIPS/SIPS and SonarWiz support our native JSF files for post-processing.  

For further information on third-party interfacing with Discover Bathymetry, refer to the THIRD-PARTY 

SOFTWARE section of this manual.  

1.3.5 Sonar Deck Cable 
The sonar deck cable is a 20-meter (65 ft) underwater, high-speed network data 
and power cable that connects the sonar head to the topside. The deck cable 
includes Cat 5e 4-pair stranded conductors that meet or exceed TIA 568-B and 
is suitable for 10Base-T and 100Base-T. The deck cable is terminated with a 16-
pin wet mate connector on both ends, has a breaking strength of 545 kg (1200 
lbs), and provides power and telemetry to 6205s2 Sonar Head. Refer to FIGURE 

2-5 for a wiring diagram of this cable. 

 

1.4 Optional Equipment  
• Adaptor Flange Kit 

• 3rd party rugged laptop computer for data collection and post-processing 

• 3rd party RTK GNSS aided INS unit, COTS (Commercial Off The Shelf) 

• 3rd party Sound Velocity Profiler unit 

1.4.1 Adaptor Flange Kit 
An adaptor flange kit is available if the standard 6205s2 three-hole 
pattern will not mate with a customer’s static pole mount or flange. 
The kit includes a durable adaptor flange plate that is designed to be 
attached to the 6205s2 mounting plate using the kit’s included 
hardware.  Kit instructions are found in this manual’s ADAPTOR FLANGE 

INSTALLATION KIT section. 

Figure 1-6: Optional Adaptor Flange 
Plate 

Figure 1-5: Sonar Deck 
Cable 
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Figure 1-7: 6205s2 with Optional Adaptor Flange Plate Installed 

1.4.2 EdgeTech Ruggedized Getac Laptop 
EdgeTech offers an optional Ruggedized Getac 
Laptop, preloaded with EdgeTech’s Discover 
Bathymetric Software and all supporting software. 
The laptop has the specifications below: 

• Windows 10 Professional Operating System 
• Intel® Core™ i7-8650U vPro 1.9GHz 

processor with Turbo Boost Technology 
• 8 GB of Memory (RAM) 
• 1TB Hard Drive 
• Intel UHD Graphics 620 
• NVIDIA Quadro M2000M (4GB GDDR5) 
• 3 USB 3.0 (9-pin) 
• 1 USB 2.0 (4-pin) 
• 1 Ethernet RJ45 Port 
• 1 Mini Display Port1 HDMI Port 
 
 Figure 1-8: GETAC Laptop Computer 
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1.4.3 SBG Systems Ekinox 3, with Septentrio AsterX4 RTK GNSS Kit 
EdgeTech is currently offering an SBG Ekinox 3 Inertial system 
with a Septentrio Asterx-m3 RTK GNSS Kit.  The Ekinox is a 
MEMS-based inertial system that includes an internal 
measurement unit (IMU) and extended Kalman filter (EKF).  The 
Septentrio AsterX4 Real Time Kinematics (RTK) and Global 
Navigation Satellite System (GNSS) provide highly-rated RTK 
position accuracy and all in view satellite tracking on three 
frequencies. In addition, EdgeTech can integrate the internal 
components, provide configuration and the necessary external 
cabling and antennas. Contact your EdgeTech salesperson or 
EDGETECH CUSTOMER SERVICE for details. 

 

 

 

Figure 1-10: 6205s2 System with RTK GNSS Kit 

Figure 1-9: GNSS Antenna and Cabling 
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1.4.4 GNSS/INS Unit Deck Cable 
A GNSS/INS deck cable is required for the 6205s2 OEM Integrated GNSS/INS 
unit option. EdgeTech’s GNSS/INS cable is a 20-meter (65 ft) underwater, 
high-speed network data and power cable that links the processing module 
to the IMU. The cable is a double-screened RS422/485 data cable with 
three twisted pairs and three power conductors. It is terminated with an 
eight-pin sea waterproof wet mate connector on both ends and has a 
breaking strength of 545 kg (1200 lbs).  Refer to FIGURE 2-6 for a wiring 
diagram of this cable. 

 

CAUTION! Do Not use this cable for towing. It should never be bearing 
the weight of the sonar head. 

 

1.4.5 GNSS/INS Antenna Cable 
Two GNSS/INS antenna cables are required for the 6205s2 OEM Integrated 
GNSS/INS unit option. The GNSS/INS antenna cable is typically a 10-meter (30 
ft) coax signal and power cable. The antenna cable links the GNSS processing 
module to each antenna. EdgeTech currently provides Times Microwave 
Systems (WWW.TIMESMICROWAVE.COM) LMR®-240 Flexible Low Loss 
Communications Coaxial Cable with TNC connector cables. 

  

Figure 1-11: GNSS/INS Deck 
Cable 

Figure 1-12: GNSS/INS 
Antenna Cable 
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2.0  SPECIFICATIONS 
This section details the 6205s2 system specifications. 

2.1 Physical Specifications 

PHYSICAL 
Size Without Adaptor Flange: 

L: 72.7 x W: 20.2 x H: 13.9 cm (28.6 x 7.9 x 5.5 in) 
With Adaptor Flange: 
L: 72.7 x W: 20.2 x H: 18.6 cm (28.6 x 7.9 x 7.4 in) 

Weight Without Adaptor Flange:14 kg (32 lbs) 
With Adaptor Flange:19 kg (40 lbs) 

Construction 316 Stainless Steel Frame 
Color Blue Angels Yellow 
Sealing O-Ring Seal with Purge Valve 

Table 3-1: Physical Specifications 

2.2 Acoustic Specifications 
SONAR HEAD 

MODEL 520/850/1600 KHZ SS – 520/820 BATHY 

SIDE SCAN SONAR 
Center Frequency 520/850/1600 kHz 
Range (per Side) 150/75/35 m (490/245/115 ft) 
Range Resolution 
Dependent on 
environmental conditions 
(absorption, 
reverberation, sea noise) 

10/9/6 mm (0.4/0.35/0.24 in) 

Beam Width Along 
Track 

0.36°/0.29°/0.20° (2-way) 

Depression Angle 35° 

MPES BATHYMETRY 
Center Frequency 520/850 kHz  
Maximum Swath 200/75 m (655/246 ft) 
Beam Width 
Along/Across Track 
resolution expressed as 
a beamwidth at nadir 

1/0.5° / 1/0.4°  

Ping Repetition 
Rate 
(Both Sides 
Simultaneously) 

15 m (16 ft) = 50 Hz 
25 m (82 ft) = 30 Hz 
50 m (164 ft) = 15Hz 
100 m (328 ft) = 8 Hz 
200 m (656 ft) = 4 Hz 
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Max Swath Sector 200° 
Max Number of 
Soundings/Ping 

800 

Sounding 
Patterns 

Equidistant and Equiangular, auto-EquiDistant 

SYSTEM 

Pulse Modulation CW & FM CHIRP 
Construction 316 Stainless Steel Frame 
Dimensions Without Adaptor Flange: 

L: 72.7 x W: 20.2 x H: 13.9 cm (28.6 x 7.9 x 5.5 in) 
With Adaptor Flange: 
L: 72.7 x W: 20.2 x H: 18.6 cm (28.6 x 7.9 x 7.4 in) 

Deck Cable 
Length 

20m (Standard) 

Depth Rating 50 m 
Weight (In Air) Without Adaptor Flange:14 kg (32 lbs) 

With Adaptor Flange:19 kg (40 lbs) 
Input Voltage 48-60 VDC 
Power 

(Typical /Max) 
55W / 70W 

Data Products Bathymetry, Backscatter, Side Scan Imagery, and Real-Time Uncertainties 

Table 3-2: Acoustic Specifications 

2.3 Power Requirements 

POWER REQUIREMENTS 

DC Input Range 36-60 VDC (48 VDC Nominal) 

Table 3-3: Power Requirements  

2.4 Environmental Specifications 

Table 3-4: Environmental Specifications 

ENVIRONMENT 
Operating Temperature 0°C to 40°C (32°F to 104°F)  
Storage Temperature -20°C to 60°C (-4°F to 140°F) 
Relative Humidity Operating 0 to 80%, 

Non-Operating 0 to 100% 
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2.5 Topside Specifications 

SPECIFICATION  
Size L: 48.3cm x W: 52.1cm x H: 8.9cm  

(L: 19 x W: 20.5 x H: 3.5 ) 
Weight 5.4 kg (12 lbs) excl INS parts 

6.4 kg (14 lbs) incl INS parts 
Construction Aluminum 
Interfaces (1) Sonar Deck Lead 

(1) 1 PPS TTL via BNC 
(1) Trigger TTL In via BNC 
(3) 100 BaseT Ethernet Ports 
(3) Serial RS-232 Ports 
 
Optionally extra for INS unit 
(1) IMU Deck Lead 
(1) 1 PPS (out) via BNC 
(2) GNSS antenna via TNC 
(1) Serial RS-232 Port for RTK 
(2) Serial RS-232 Ports 

Input Power Supply 115/230 VAC Auto-Sensing 
Output Power Supply 60VDC 
Current Draw 1.40A 

Table 3-5: 6205s2 Topside Interface Specifications 
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2.6 Mechanical Drawings 
This section contains supporting drawings for the 6205s2 Swath Bathymetry and Dual Frequency Side Scan Sonar System: 

2.6.1 6205s2 Sonar Head Drawing 

Figure 2-1: 6205s2 Sonar Head ICD 
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Figure 2-2: 6205s2 Sonar Head with Adaptor Flange ICD 
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Figure 2-3: 6205s2 Side Scan Transducer 
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Figure 2-4: 6205s2 Side Scan Transducer Details
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Figure 2-5: 6205s2 Deck Cable Wiring Diagram 
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Figure 2-6: 6205s2 GNSS/INS Deck Cable Wiring Diagram 
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2.6.2 6205s2 Topside 
 

 
Figure 2-7: 6205s2 Rack-Mounted Topside 
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Figure 2-8: 6205s2 Rack Mount in Case 
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3 .0  TECHNICAL DESCRIPTION 

The complete 6205s2 system consists of a sonar head, a topside interface box, and an attached topside 
computer. This section describes the 6205s2 System's main components and provides drawings for system 
integration and operations. 

3.1 The 6205s2 Sonar Head 
The 6205s2 is a lightweight, durable, hydrodynamic sonar head designed for side scan and bathymetric 
surveys.  The sonar electronics are contained inside a single housing, and two dual side scan and 
bathymetric arrays are mounted on the port and starboard sides of the vehicle. A sound velocity sensor 
is housed in the nose cone. A deck cable connector and optional GNSS/INS cable connector are located 
on the top aft section of the sonar head. 

 

 

 
Figure 3-1: 6205s2 Sonar Head Port View 

 

 
Figure 3-2: 6205s2 Aft View 

 
Figure 3-3: 6205S2 

Forward View 

 
Figure 3-4: 6205s2 Nose Cap 
Removed- AML SVT OEM Probe 
Visible and Optional Adaptor 
Flange Installed 

 

Nosecone Housing Sound 
Velocity Sensor 

Mounting Plate 
Deck Cable 
Connector 

[2] Dual-Frequency + Bathymetric Sonar Arrays (Port and Starboard Sides) 

GNSS/INS Cable 
Connector 

Housing 
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3.1.1 Sonar Arrays 
The 6205s2 provides single-frequency bathymetry and simultaneous dual-frequency side-scan sonar. The 
6205s2 Swath Bathymetry and Side Scan Sonar Head are available in a variety of frequency options:  

• 520 / 850 kHz Dual Frequency Side Scan with 520 kHz Bathymetry Data 
• 520 / 850 kHz Dual Frequency Side Scan with 850 kHz Bathymetry Data 
• 520 / 1600 kHz Dual Frequency Side Scan with 520 kHz Bathymetry Data 
• 850 / 1600 kHz Dual Frequency Side Scan with 850 kHz Bathymetry Data 

The frequency sets listed above were chosen to provide optimum results for any given water depth up to 
50m (165ft) below the transducer. The 6205s2 is pressure-rated for water depths between 1m – 50m (3ft 
– 164ft). The optimal frequency depends on survey requirements. 

The 6205s2 utilizes two arrays (port and starboard) to map the seafloor, much like a dual-head multibeam 
system. Each 6205s2 array is constructed using ten independent longitudinal PZT elements and two multi-
segment PZT strings. The two multi-element strings (one per side scan frequency) are used for the 
transmit function and as a full-resolution side-scan receiver. The remaining ten elements make an 
approximately half-wavelength spaced array of sensors for its bathymetry receiver. 

3.1.2 Sonar Head Housing 
The pressure housing and end caps are made of painted hard coat anodized aluminum. The nose cone 
and array covers are made of a urethane elastomer. The housing supplies a streamlined body for efficient 
underwater maneuvers rated up to 10 knots while protecting the SVS, arrays, and deck cable connections. 

CAUTION! Although the 6205s2 can handle transit up to 10 knots, survey 
speeds should be constrained to 4-5 knots or less. EdgeTech recommends 
recovering the Sonar Head from the water during transit above 7-8 knots 
(unless the unit is installed inside a suitable hull fairing).  

3.1.2.1 Sonar Processor 

The 6205s2 Sonar Processor has a built-in Windows® Embedded PC. The main firmware installed on the 
embedded PC is Sonar.exe, which controls the sonar’s hardware and performs specific functions, such as 
signal processing and time synchronization of the acquired data. 
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3.1.2.2 Sonar Processor Endcap and Pinout Drawings 

 

Figure 3-5: 6205S2 Forward End Cap 
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Figure 3-6: 6205s2 Aft End Cap
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Figure 3-7: 6205s2 Pinout Drawing 

3.1.2.3 Sound Velocity Sensor 

The 6205s2 Sonar Head nosecone is a flooded section 
that houses an AML Sound Velocity Sensor (SVT), which 
provides a response time of 47 μs, a resolution of 0.001 
m/s, and a theoretical accuracy of ±0.025 m/s.  

EdgeTech recommends collecting a sound velocity 
profile, especially in the area where you collect survey 
data. The water being operated in likely does not have 
a uniform sound velocity, and depending on how drastic 
the profile is, a depth error as large as 1.6 m has been 
observed. 

 

 

 
Figure 3-8: Sound Velocity Sensor 
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3.1.3 Mounting Plate 
The 6205s2 Mounting Plate is made of electropolished 316 stainless steel and was designed with a three-
bolt pattern to securely fix the system to the customer’s mounting fixture, thereby cutting back on 
installation and mobilization time. The bolt pattern is shown in FIGURE 3-9. 

EdgeTech advises mounting the 6205s2 Sonar Head to the bow of a survey vessel. By placing the system 
at the bow, the sonar should be far enough away from most interference, such as hull echoes, propeller 
noise, and wake. 

 

Figure 3-9: The Mounting Plate 

Edgetech does offer an OPTIONAL ADAPTOR FLANGE KIT to accommodate pole mounts and flanges that don’t 
match the plate’s three-bolt pattern.  

 

Figure 3-10: The Optional Adaptor Flange Installed onto the Mounting Plate 
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3.1.4 Acoustic Center 
The individual acoustic centers of each array (port and starboard) converge at a single point along the 
centerline of the 6205s2 Sonar Head. Therefore, when entering sonar head offsets into the third-party 
acquisition and processing software, the port and starboard array offsets (sometimes referred to as Sonar 
Head 1 and Sonar Head 2) are identical in all dimensions.  

Remember that the individual acoustic centers for both port and starboard converge on the centerline (or 
X = 0).  

NOTE: The acoustic center along the y-axis is different for the 520kHz 
model than the 850kHz model.  
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Figure 3-11: 6205s2 Acoustic Center Location (X,Y,Z) and Bolt Pattern   
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Figure 3-12: 6205s2 with Adaptor Flange Acoustic Center Location (X,Y,Z) and Bolt Pattern 
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3.2 The 6205s2 Topside Sonar Interface Box 
The 6205s2 Topside Sonar Interface Box has two purposes:  

1. To provide power to the Sonar Head 
2. To provide a direct link between Sonar Head, any supporting sensors, and Topside Computer. 

The topside sonar interface box delivers power to the system and transmits/receives data via the provided 
20m (65ft) Deck Cable and a SubConn 16-pin wet mate connector. The topside supplies ethernet ports to 
communicate with the topside computer and provide navigation and data from connected sensors. The 
topside also has (3) RS-232 serial ports to intake navigation, heading, and altitude data from the 
supporting sensors.  

CAUTION! When the 6205s2 is purchased with an OEM Integrated RTK 
GNSS aided INS unit, there is no need to use the RS-232 or LAN ports to 
receive data from peripheral GNSS/Heading/Motion sensors! 

 

The 6205s2 Topside Sonar Interface Box serial ports are configured to meet specific requirements. The 
first two RS232 serial ports are configured for high speed and high accuracy, while the third RS232 serial 
port is configured for standard serial connections. Typical latencies for the high speed/high accuracy ports 
are less than 100us, whereas the standard serial port may have up to 100ms. The high-speed ports are 
unidirectional; however, data cannot be transmitted from the 6205s2 to an external device. All three 
communications ports are isolated via a proprietary signal conditioning isolator board. This ensures noise 
generated or carried by grounds on the survey vessel does not generate artifacts in the side-scan and 
bathymetry data sets. 

The 6205s2 can receive navigation and altitude data from supporting sensors via the ethernet connection 
utilizing UDP. Refer to SECTION 8.3.4 UDP CONNECTIONS in this manual for more information on configuring 
6205s2 for UDP data transfer.  

The 6205s2 Topside is delivered with a USB drive that contains system manuals and EDGETECH’S DISCOVER 

BATHYMETRIC ACQUISITION SOFTWARE. Optional laptops come preloaded with EdgeTech’s Discover 
Bathymetric Acquisition Software and all user manuals. The newest manuals can be downloaded from the 
EdgeTech product pages and SUPPORT CENTER RESOURCE WEBPAGE.  

https://www.edgetech.com/resource-center/
https://www.edgetech.com/resource-center/
https://www.edgetech.com/resource-center/
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3.2.1 6205s2-R Rack Mount Topside Interface Box 
The 6205s2-R Rack Mount 
Topside Sonar Interface Box was 
designed to slide into a 19-in Rack 
Mount SKB® Case or shelf. The 
serial and Ethernet ports act as a 
dry connection to the sonar head 
for all ancillary information (i.e., 
position, attitude, time, etc.) and 
data from the sonar head to the 
topside computer. BNC and TNC 
connectors provide connections 
to optional OEM/SBG devices and triggers. The front panel power switches and indicators power topside 
components and give information on their status.   

Refer to TABLE 3-6: 6205S2-R TOPSIDE CONNECTORS, SWITCHES, AND INDICATOR LIGHTS below for detailed 
topside component information and to the CONNECTIONS AND FORMATS section of the manual for 
system configuration instructions. 

3.2.1.1 6205S2-R Topside Connectors, Switches, and Indicator Lights 

 

Figure 3-14: Rack Mount Topside, Front Panel  

 

Figure 3-15: Rack Mount Topside, Rear Panel  

 

 

 

 

Figure 3-13: 6205s2-R Topside Interface 
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FRONT PANEL 6205S2-R   

SONAR Power Switch Rocker switch that turns the system on or off. The rear line power switch 
needs to be turned on for this switch to function. 

SONAR Indicator Light A Green LED that indicates power is being output to the vehicle.  

GNSS/INS Power Switch Rocker switch that turns the power to the GNSS/INS system on or off. 

GNSS/INS Indicator Light 
A Green LED that indicates power is being output to GNSS/INS device. 
This LED is included regardless of whether the OEM GNSS/INS kit is 
purchased. The LED will illuminate if no OEM kit is installed.  

BACK PANEL 6205S2-R  

Line VAC Connector Connection for the AC power cord. 

Line Power Switch Rocker switch that switches AC power to the front panel POWER switch  

AC Fuse 5A 250VAC Fuse (PN# 0003728) 

Network Ethernet 
Connectors (3) 

RJ-45 Standard Ethernet connections. The top left port is typically 
connected to the computer.   

SONAR Connector Subconn 16 MCIL16F input connector for MCIL16M deck cable 
connector. Connect the topside to the sonar head. 

IMU Connector Subconn 8 MCIL8F input connector for MCIL8M IMU cable connector. 

1PPS Sonar In BNC  BNC connection to Pulse Per Second device. 

1 PPS GNSS Out BNC BNC connection to the GNSS/INS system. 

EXT Trigger In BNC BNC connection to an external input trigger. 

GNSS/INS RTK Input Serial 
Port 

Input only RS232 serial port connector to GNSS/INS system. If a 
GNSS/INS isn’t integrated, the connector is disconnected internally. 

GNSS/INS Port A Input 
Serial Port 

Bidirectional RS232 serial port connector to GNSS/INS system. If a 
GNSS/INS system isn’t integrated, the connector is disconnected 
internally. 

GNSS/INS Port B Input 
Serial Port 

Bidirectional RS232 serial port connector to GNSS/INS system. If a 
GNSS/INS system isn’t integrated, the connector is disconnected 
internally. 

Sonar COM 1 Serial Port High-speed unidirectional RS232 serial port connector. 

Sonar COM 2 Serial Port High-speed unidirectional RS232 serial port connector. 

Sonar Com 3 Serial Port Standard Bidirectional RS232 serial port connector. 

GNSS Antenna ANT 1 TNC TNC connection for GNSS antenna. If a GNSS/INS system isn’t 
integrated, the connector is disconnected internally. 

GNSS Antenna ANT 2 TNC TNC connection for GNSS antenna. If a GNSS/INS system isn’t 
integrated, the connector is disconnected internally. 

Table 3-1: 6205s2-R Topside Connectors, Switches, and Indicator Lights 



   3-51 

  
   

NOTE: The customer must provide a computer to run the Discover 
software application for the rack mount topside sonar interface box 
option. Minimum computer requirements are found in sub-section 3.2.3 
of this manual. 

If the 6205s2-R Rack Mount Topside Interface Box does not turn on, check the on/off switch on the back 
panel. It is located next to the power plug. 

CAUTION! When the 6205s2 is purchased with an OEM Integrated RTK 
GNSS aided INS unit, there is no need to use the RS-232 or LAN ports to 
receive data from peripheral GNSS/Heading/Motion sensors! 

3.2.2 6205s2-S Stack Topside Interface 
Custom minimal topsides are available on a case-by-case basis. Please contact your EdgeTech salesperson 
for more information.  

3.2.3 Topside Computer Requirements Specifications 
The topside computer must be able to run EdgeTech’s Discover Bathymetric Acquisition Software and any 
additional third-party software. To do so, it must include the following minimum requirements: 

• Windows 10 Professional Operating System 
• Quad-Core Intel Core i7-4900MQ @ 2.8GHz Processor or similar 
• 8 GB of Memory (RAM) 
• 500GB Hard Drive 
• 3 USB Ports 
• 1 Ethernet Port 
• 1 GB Graphics Card 

EdgeTech can provide an OPTIONAL GETAC LAPTOP that meets 6205s2 system requirements and comes with 
Discover preinstalled. 

CAUTION! Installing additional software outside the provided EdgeTech 
and third-party bathymetric software is NOT recommended. Installing 
software other than those supplied can have undesirable effects, such as 
poor and/or slow performance when acquiring Bathymetry and dual-
frequency Side Scan data. A list of approved third-party packages is 
provided in THIRD-PARTY SOFTWARE.  
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CAUTION! The laptop’s performance can change when running on 
internal battery power. Therefore, EdgeTech recommends ensuring the 
laptop is plugged into AC power when operating with the sonar and 
acquiring real-time bathymetry and side-scan data.  
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4 .0  CONNECTIONS AND FORMATS 

The 6205s2 system relies on specific data formats and connections to produce high-quality images and 
measurements. This section describes these data formats and connections and provides diagrams to 
better understand the system's hardware and data flow. 

4.1 Data Formats 

CAUTION! When the 6205s2 includes the OEM Integrated RTK GNSS 
aided INS unit, there is no need to use the RS-232 or LAN ports to 
receive data from peripheral GNSS/Heading/Motion sensors. 

Data from 3rd party peripheral sensor(s) are required to support correctly output geo-referenced 
soundings and side scan sonar data surveys. At a minimum, the following peripheral data is needed: 

a. TimeSync and 1PPS, Position, true north Heading, Motion (heave/roll/pitch). 
b. GNSS Position in NMEA or supported 3rd party format, latitude and longitude, and height; 

minimum of 5Hz 

c. Heading data in NMEA format or supported 3rd party format; minimum of 20Hz 

d. Attitude or roll/pitch/heave data in or supported 3rd party format; minimum of 50Hz 

e. Time sync data in NMEA or supported 3rd party format; minimum of 1Hz 

f. 1PPS TTL, typically from the GNSS receiver 

Data may be supplied by 1, 2, or 3 individual sources (sensors) and are listed below in order of priority. 

a. Position Data – this may be supplied via any (one) of the following type sentences/messages: 

i. $xxGGA NMEA 
ii. $xxGLL NMEA 

iii. $xxRMC NMEA 

$xxGGK ** (Applanix PosMV format) ** = Non-NMEA standard sentences 

iv. $PTNL, GGK, … ** (Trimble format, non standard NMEA) 
v. 3rd party proprietary messages, at 50Hz, like Applanix POS-MV grp 102 or SBG EKF or iXBLUE 

StndBinary, etc. Contact EdgeTech for further details of supported messages 

b. True North Heading Data – this may be supplied via: 

i. NMEA, $xxHDT sentence, OR 
ii. EM3000 binary format together with motion data 
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iii. 3rd party proprietary messages, at 50Hz, like Applanix POS-MV grp 102 or SBG EKF or iXBLUE 
StndBinary, etc. Contact EdgeTech for further details of supported messages 

c. Attitude (Roll, Pitch, and Heave) Data – this may be supplied via: 

i. TSS1 format, OR 

ii. EM3000 binary format 

iii. 3rd-party proprietary messages, like Applanix POS-MV grp 102 or SBG EKF or iXBLUE 
StndBinary, etc. Contact EdgeTech for further details of supported messages 

d. Time Input - supported sentences are in order of priority/use 

i. $xxZDA 

ii. $xxRMC 

iii. $xxGGK (derived from data in item a. above)  

iv. $xxGGA (only supports time, no date field) 

v. $xxGLL (only supports time, no date field) 

vi. 3rd-party proprietary messages, like Applanix POS-MV grp 102 or SBG EKF or iXBLUE 
StndBinary, etc. Contact EdgeTech for further details of supported messages 

NOTE: The prefix “$xx” represents a specific manufacturer's proprietary 
NMEA message prefix. $GPGGA, $GPZDA, etc., are examples of NMEA 
output sentences for a Hemisphere GPS. 

We recommend you also supply the system with a source of Speed Over 
Ground in NMEA format (i.e., VTG, minimum of 1Hz) so that the system 
can correctly compute Along-Track Distance between each ping and 
display it in Discover Bathymetric Software.  

 

NOTE: It is most strongly recommended to use 1PPS timesync together 
with 3rd party proprietary messages, like Applanix POS-MV grp 102 or 
SBG EKF or iXBLUE StndBinary, etc., as only these such messages are 
accurately UTC time-tagged at source and the UTC time is included as part 
of the data stream sent to the sonar unit. Failure to use such data that is 
accurately UTC time-tagged will nearly always result in data artifact of 
some kind that is not the fault of the EdgeTech sonar system. 
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4.2 System Connections and Data Flow 
The following sub-sections describe the connections and data flow for the 6205s2 System. 

4.2.1 Ethernet LAN Connections 
The Ethernet LAN connection from the sonar head to the 6205s2 topside interface is made using a physical 
wired connection via the standard 20m (65 ft) Deck Cable. The 6205s2 sonar interface connects to a 
topside computer via a standard RJ-45 ethernet plug. The (default) correct IP addresses for the sonar head 
and topside computer are as follows: 

Standard Configuration: 

• Sonar Head IP Address = 192.9.0.101 
• Topside Computer IP Address = 192.9.0.99 

NOTE: Factory defaults for the 6205s2 Sonar head IP address is 
192.9.0.101 and should not be changed for any reason. The optional 
laptop will also be preconfigured to 192.9.0.99 on delivery from 
EdgeTech. When the customer supplies their own topside computer, the 
IP address needs to be set to an address similar to the above. 

Options: 

• SBG Ekinox = 192.9.0.51 
• Septentrio GNSS = 192.9.0.50 

The 6205s2 can receive data from supporting sensors via the ethernet connection utilizing UDP. Refer to 
the UDP CONNECTIONS section of the manual for more information on configuring 6205s2 for UDP data 
transfer.  

Optionally, when the system includes the OEM SBG, there is no need, in a loop-back style, to send 
time/position/attitude to the sonar as the INS data is internally transferred via the ethernet connection.  

4.2.2 Serial Port Connections 
There are three RS-232 serial ports provided on the 6205s2 Sonar Interface box. COM1 and COM2 have 
been configured for high speed and high accuracy). COM3 is configured for standard RS-232 serial 
connections. Typical latencies for the high speed/high accuracy ports are less than 100us, whereas the 
standard serial port has up to 100ms. 

These serial ports are provided to intake the navigation, heading, and attitude (roll, pitch, and heave) data 
from the supporting sensors. The CONFIGURING COM PORTS section of this manual has instructions to 
configure them. 
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Optionally, when the system includes the OEM SBG, there a two RS-232 (Port A/B) for data from the 
GNSS/INS unit. Note, these RS-232 ports are not needed in a loop-back style to send 
time/position/attitude to the sonar as the INS data is internally transferred via the ethernet connection. 
Also, there is one RS-232 (RTK Input) that should be used to send the data stream from an RTK Corrections 
Service to the GNSS/INS unit (and the NMEA GGA from the GNSS/INS unit to the RTK Service) via an 
externally connected Internet modem and using the NTRIP protocol. 

4.2.3 Hardware Connectivity 
FIGURE 4-1 is a block diagram that illustrates interconnections between the 6205s2-R Rack Mount Topside 
Interface and all supporting sensors. This illustration gives examples of three possible sensor 
configurations that are explained below. 

   
Figure 4-1: 6205s2 Rack Mount Topside Interface Connections 

In FIGURE 4-1, the 6205s2 topside interface connects to the sonar head via deck cable. Time and 1PPS, 
navigation, heading, roll, pitch, and heave data from supporting sensors via COM ports 1, 2, and/or 3 and 
1PPS, are inputted at the sonar interface, passed through the deck cable, and processed by the sonar 
processor in sonar head.  

These processed navigation and attitude data are transmitted (along with the raw side-scan data) with a 
common timestamp up the deck cable to the 6205s2 sonar interface. Together, they are then passed to 
the topside computer through an Ethernet cable and via the 100Mbps link on an Ethernet port (IP Address: 
192.9.0.99).  

Heading,  
Position, Time 

Attitude, Heading, 
Position, Time 

Heading 

Roll/Pitch/Heave 

Position 
1PPS 

6205s Sonar Head 
IP Address: 192.9.0.101 

Example 1 

 

Attitude 

Not Used 

Example 2 

 

Example 3 

 

Power 
115/220 VAC 

Not Used 

Not Used 

Topside Computer 
IP Address 192.9.0.99 
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The topside computer then processes the data using the Discover Bathymetric software to send 
amplitude, angle, and range data to the 3rd party software for logging and post-processing. This process 
is explained in further detail in the following section. The 3rd party software and Discover Bathymetric 
processors may all run on the same topside computer. 

4.2.3.1 Serial Port Configuration Examples 

CAUTION! When the 6205s2 includes the OEM Integrated RTK GNSS 
aided INS unit, there is no need to use the RS-232 or LAN ports to 
receive data from peripheral GNSS/Heading/Motion sensors. 

Example 1 in FIGURE 4-1 depicts a sensor interfacing to the 6205s2 sonar interface that provides time and 
1PPS, navigation (latitude/longitude), heading, roll, pitch, and heave data over one serial connection—
such as a NovaTel ProPak 6 or Applanix POS-MV or SBG Systems (RS-232 data output, not Ethernet data 
output). As depicted in FIGURE 4-1, the sensor is connected to COM1.  

Example 2 shows the most common interfacing scenario, a GNSS that provides navigation and heading 
and time data, accompanied by a separate motion sensor for heave/roll/pitch measurements.  

The COM ports should be assigned as such: 

• COM1 = MRU (Roll, Pitch, Heave) 

• COM2 = GNSS (Navigation and Heading and Time) 

• 1PPS = 1PPS TTL from the GNSS unit 

These assignments may be interchanged between COM1 and COM2 because both ports have been 
configured for high speed and accuracy. COM3 should not be used in this scenario. 

Example 3 portrays a situation where the GNSS does not provide heading data. In this case, three sensors 
are required: a GNSS for navigation (latitude/longitude/height and time), a gyrocompass for heading, and 
a motion sensor for roll, pitch, and heave measurements.  

Therefore, all three COM ports should be used and assigned as follows:  

• COM1 = MRU (Roll, Pitch, Heave) 

• COM2 = Gyrocompass (Heading) 

• COM3 = GNSS (latitude/longitude/time) 

• 1PPS = 1PPS TTL from the GNSS unit 

The sensors allocated to COM1 and COM2 may be interchanged for the same reason stated in the second 
example. GNSS data, or latitude and longitude and height data, must be allotted to COM3 because 
position messages include a valid timestamp. In contrast, attitude and heading messages accepted by 
6205s2 do not have a valid time tag. 
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NOTE: To configure the serial ports according to the examples given 
above, see CONFIGURING COM PORTS. 

4.2.3.2 Ethernet Port Configuration Examples 

CAUTION! When the 6205s2 includes the OEM Integrated RTK GNSS 
aided INS unit, there is no need to use the RS-232 or LAN ports to 
receive data from peripheral GNSS/Heading/Motion sensors. 

The 6205s2 can receive navigation and altitude data from supporting sensors via the Ethernet connection 
utilizing UDP. Refer to SECTION 8.3.4 UDP CONNECTIONS for more information on configuring 6205s2 for UDP 
data transfer. 

FIGURE 4-2 depicts a sensor interface to the 6205s2 topside interface that provides a time and 1PPS 
connection and a navigation (latitude/longitude), heading, roll, pitch, and heave data connection over an 
ethernet connection (Ethernet 1). Systems that include an Applanix POS-MV or SBG Systems would use 
this configuration.  

 

  
Figure 4-2: 6205s2-R Rack Mount Topside Interface Connections 

Attitude, Heading, 
Position, Time 

6205s Sonar Head 
IP Address: 192.9.0.101 

Example 1 

 

Power 
115/220 VAC 

Topside Computer 
IP Address 192.9.0.99 

1PPS 
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NOTE: The 6205s2-S Stack topside interface connections are similar. 

4.2.3.3 Integrated GNSS/INS Port Configuration Example 

Optionally, the 6205s2 can receive navigation and altitude data from an integrated GNSS/INS system unit 
via the Ethernet connection utilizing UDP.  

FIGURE 4-3 depicts a sensor interface to the 6205s2 topside interface that provides a time and 1PPS 
connection and a navigation (latitude/longitude), heading, roll, pitch, and heave data connection over an 
ethernet connection (internal to topside unit).  

When using the GNSS/INS system, an external cable is used to loopback the 1PPS signal from the “GNSS 
Out” BNC connector to the “Sonar In” BNC Connector.  

Examples of OEM units include the SBG Systems  

 

  
Figure 4-3: 6205s2-R Rack Mount Topside Interface Connections 

 

For more information, refer to the DISCOVER BATHYMETRIC SOFTWARE USER MANUAL. 

Attitude, Heading, 
Position, Time 

6205s Sonar Head 
IP Address: 192.9.0.101 

Example 1 

 

 

Power 
115/220 VAC 

Topside Computer 
IP Address 192.9.0.99 

1PPS 

https://www.edgetech.com/resource-center/
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4.2.3.4 One PPS Port Configuration 

One Pulse Per Second (1PPS) is a feature in many GNSS units to provide an accurate timing mechanism to 
synchronize various devices to a precise, common clock. The Edgetech 6205s2-R (FIGURE 4-2.) rack-mount 
provides a 1PPS port to physically connect to a PPS-capable unit. The logical configuration is done in the 
attached GNSS configuration and activating the 1PPS option in EDGETECH’S DISCOVER BATHYMETRIC 

SOFTWARE.  

CAUTION! The 6205s2 system is optimized to work with a falling edge 
1PPS signal. 

 

The EdgeTech Isolator Board identifies the input signal's falling edge and reconstitutes it as a rising edge 
2.27ms pulse. This signal is passed down the deck cable to the subsea electronics, where the rising edge 
is utilized as the 1PPS time sync reference. Refer to FIGURE 4-4. This configuration produces negligible 
latency when a falling edge 1PPS signal is injected at the topside.  

NOTE: To learn more about the EdgeTech Isolator Board, refer to the 
TOPSIDE PROVIDED ISOLATION section of this manual. 

 

Figure 4-4: 6205s2 System Is Optimized To Work With A Falling Edge 1PPS Signal 

A rising edge trigger can be used when a falling edge trigger is not available. There are no software or 
hardware adjustments required. However, a latency equivalent to the input trigger’s pulse width will be 
generated. As a result, EdgeTech recommends using a pulse width (duration) of not longer than 1ms if a 
rising edge trigger must be used. Static latency correction occurs during the patch test process in third-
party software packages. 

https://www.edgetech.com/resource-center/
https://www.edgetech.com/resource-center/
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4.2.4 Sonar Data Flow 
The Discover Bathymetric software acquisition package provides a way to control, store, and display the 
bathymetry and side-scan sonar data. Discover Bathymetric contains two sub-modules. The first is the 
Bathymetric Processor, which processes the bathymetry solutions. The second is the Discover application, 
that processes and displays the dual-frequency side-scan data. If third-party software is utilized, it would 
be added to the data flow. The Sonar Data Flow Chart below (FIGURE 4-5) illustrates the data flow between 
Discover, the Bathymetric Processor, and any third-party software. 

 
Figure 4-5: Sonar Data Flowchart 

The flow chart in FIGURE 4-5 demonstrates the following:  

1. The auxiliary sensors provide time, heading, position (latitude/longitude), and motion (roll, pitch, 

and heave) data to the 6205s2 Topside Interface Box via the provided RS-232 serial ports or UDP 

connections over the ethernet link. 

2. Auxiliary data is then relayed without additional latency to the 6205s2 Sonar Head via the deck 

cable.  
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3. Auxiliary data is then combined with the raw sonar data and instantaneous sound velocity (SV) 

measurements. They are time-stamped with a common value and then sent back to the 6205s2 

Topside Interface Box.  

4. The Discover Bathymetric application takes in the raw sonar data and sends it to the Bathymetric 

Processor. 

5. The Bathymetric Processor processes the raw sonar data to produce uncorrected range and angle 

data and then transmits this back to the Discover Bathymetric application, where it is packaged 

with the auxiliary and dual-frequency side-scan data. At this point, each ping is represented by a 

complete data package containing all sonar and auxiliary data.  

NOTE: Once the data is passed back to Discover Bathymetric, data is 
displayed on the provided graphical displays to illustrate the bathymetry 
and simultaneous dual-frequency side scan data in real-time. The data 
may also be recorded as a *.JSF file if the user desires. 

6. The completed data package (range/angle, dual-frequency side scan, and all auxiliary data) is sent 

to the third-party software. 

7. The third-party software processes these complete data packets to a native format. The third-

party software also provides graphical displays to show the bathymetry, dual-frequency side scan, 

and auxiliary data.  

8. Finally, the third-party software saves native data files that contain every piece of information to 

post-process the data and generate final hydrographic products. 
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4.3 Topside Provided Isolation 
The two most common sources of electrical noise (interference) are power supplies and poor grounding 
on survey vessels. Edgetech’s proprietary signal conditioning and isolation board is shipped with every 
topside to protect against the noise fluctuations on the ground line of the subsea electronics. This board 
isolates the sensitive subsea electronics from potentially noisy grounds provided by the trigger and serial 
port inputs. Noise can often be identified as repeating patterns at the edge of the usable range of data 
within Discover’s waterfall display.  

 

Figure 4-6: Chevron Pattern Noise in a Cropped Portion of Discover Bathymetric

Chevron Pattern Noise 

Chevron Pattern Noise 
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5.0  INSTALLATION 

This section provides an overview of unpacking, inspecting, installing, and caring for the EdgeTech 6205s2 
Swath Bathymetry and Dual Frequency Side Scan Sonar System. 

5.1 Unpacking and Inspecting 
The sonar head and Topside Interface units are shipped in heavy-duty, reusable transport cases with 
appropriate packing material. All documentation, including manuals, is provided in electronic form on the 
USB thumb drive.  

Before unpacking the system’s components, inspect the shipping containers for damage. If any damage is 
found, report it to the carrier and to EdgeTech immediately. If the shipping containers appear damage-
free, carefully unpack the components and inspect them.  

Check the packing list and verify all the items on the list are included. If any damage is found after 
unpacking the components, immediately report it to the carrier and to EdgeTech. If any items are missing, 
contact EDGETECH CUSTOMER SERVICE. Do not install or operate any equipment that appears damaged. 

Although the items shipped may vary depending on the customer’s requirements, the standard 
components for the 6205s2 Swath Bathymetry and Dual Frequency Side Scan Sonar system are listed in 
MAIN SYSTEM COMPONENTS section of this manual. 

5.2 Sonar Head Installation 
Installing the 6205s2 system on the survey vessel is the customer’s responsibility, but it is important to 
keep the following considerations in mind.  

1. The sonar head can be mounted on the side of a vessel or on the underside of the vessel, but it is 

recommended to secure the 6205s2 to the boat's bow.  

2. If the customer wishes to mount the sonar off their vessel's side/underside, care must be taken 

to ensure keel clearance. 

5.2.1 Pole Mounting  
The 6205s2 is designed to be pole mounted to a pole flange using the 3-bolt plate provided on the top of 
the sonar head.  Customers can manufacture their own, or EdgeTech offers a kit that offers a flange 
adaptor plate and the necessary hardware to attach it to a customer-supplied pole. Further information 
and instructions are found in this manual's ADAPTOR FLANGE INSTALLATION KIT section. 
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5.2.2 Over-the-Bow Deployment 
Edgetech’s recommended option is to mount the 6205s2 sonar head to the bow of the survey vessel. An 
example of an over-the-bow deployment is depicted in the photographs in FIGURE 5-1. If help is needed 
with this type of installation, do not hesitate to contact EDGETECH CUSTOMER SERVICE. 

  

Figure 5-1: 6205s2 Deployment, Option 1 – Over-the-Bow 
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5.2.3 Over-the-Side Deployment 
An alternative to the bow mount is to secure the 6205s2 sonar head over the survey vessel's side via a 
pole. An example of an over-the-side deployment is illustrated in the images in FIGURE 5-2. If help is needed 
with this type of installation, contact EDGETECH CUSTOMER SERVICE. 

  

Figure 5-2: 6205s2 Deployment, Option 2 – Over-the-Side 

5.2.4 USV Deployment 
An alternative to the ship-mounted sonar is to secure the 6205s2 system to an uncrewed survey vessel. 
An example of an Unmanned Surface Vehicle (USV) deployment is illustrated in the image in FIGURE 5-3. 
Contact EDGETECH CUSTOMER SERVICE for assistance with any USV installation. 
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Figure 5-3: 6205s2 USV Deployment (IM Solutions USV) 

5.3 Positioning the Topside Interface Box 
The Topside Interface Box should be positioned to enable direct communications with the deck crew 
operating the survey vessel, sonar head, and other supporting sensors. Try and position the box out of 
areas of direct sunlight, especially in tropical environments, as heat build-up can occur, and viewing status 
indicators can become difficult to see due to brightness and glare. It should be located and set up in a dry, 
sheltered area on the survey vessel that is protected from weather and water spray.  
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6.0  CONNECT TO SONAR 

This section describes how to connect to the sonar, ensure all supporting data is present within the system 
for proper operation, and correctly time sync the 6205s2 data. It also briefly describes the EdgeTech 
Discover Bathymetric software. Refer to THE DISCOVER BATHYMETRIC SOFTWARE USER MANUAL (0014878) for 
complete software details and instructions. 

6.1 Connecting to Sonar via Remote Desktop 
A user can connect to the 6205s2’s internal computer using Window’s Remote Desktop application and 
view the sonar application (Sonar.exe) to check the status of the supporting data if a device is not 
connected properly. If this is the case, Discover Bathymetric will display its diagnostic window and show 
which serial port is causing the error. Connecting to the sonar without EdgeTech support is not 
recommended, except for the instructions below.  

 

6.1.1 Connecting with the User-supplied computer 
 

1. Navigate to the Remote Desktop using Windows ‘Start’ button > All Programs > Accessories > 

Remote Desktop Connection. Alternatively, click the Windows ‘Start’ button, type mstsc in Search, 

and hit <Enter>. The following window will appear: 

 
Figure 6-1: Manual Remote Desktop Credentials for Customer Supplied Computer 

https://www.edgetech.com/resource-center/
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2. Connect to the 6205s2 Sonar using an IP address of 192.9.0.101 and the User name, 
Administrator. 

3. When prompted for a password, input admin. Once logged on, the following window will appear 
on the desktop or be minimized: 

 

Figure 6-2: Sonar 192.9.0.101 Remote Desktop Connection Window 

This window represents the main firmware running on the embedded CPU located in the bottle 
of the sonar head. Called Sonar.exe, this program is responsible for controlling the sonar’s 
hardware and performs specific functions such as signal processing and time synchronization of 
the acquired data. 

6.1.2 Connecting with the EdgeTech supplied computer 
When using an EdgeTech supplied computer: 

1. Launch the Remote Desktop to Sonar application on the desktop screen. If prompted for a 
password, input admin.  

Once logged on, the Sonar Application will be displayed on the screen, as shown in FIGURE 6-2. 
This window represents the main firmware running on the embedded CPU located in the bottle 
of the Sonar Head. Called Sonar.exe, this program is responsible for controlling the sonar’s 
hardware and performs specific functions, such as signal processing and time synchronization of 
the acquired data. 

6.2 Confirming Supporting Data is Present 
To ensure the sonar head’s processor is communicating properly with the topside, complete the following: 

NOTE: This section assumes all auxiliary sensors have been connected to 
the 6205s2 Interface Box (whether this is the 6205s2-R or 6205s2-S), the 
sonar head is installed on a survey vessel (or reasonably setup in a 
suitable workshop environment), and it is submerged in water. 

1. Launch Remote Desktop to Sonar on the Windows desktop. The following window should appear: 
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Figure 6-3: Sonar 192.9.0.101 Remote Desktop Connection Window 

2. Click on Menu > Misc > Serial Port Information. 

3. Check each COM port in the dropdown menu to ensure the correct baud rates are set and data is 

coming through for each device and in the correct format, as shown in FIGURE 6-4. 

a. COM1 = MRU 
b. COM2 = GNSS 
c. COM4 = Sound Velocity Sensor located in the sonar head’s housing 

NOTE: GNSS and MRU are interchangeable on COM1 and COM2 as long 
as the appropriate baud rate is set in the dropdown menu next to channel 
assignment in Serial Port Information Window, as shown in Figure 6-4, 
red arrow. 

More information on how to configure the COM ports is presented in 
CONFIGURING COM PORTS. 

If all systems are working properly, close this window and proceed to Step 4. If there is an issue 
with one of the ports, contact EDGETECH CUSTOMER SERVICE. 

 

CAUTION! Sound velocity is extremely important for the system to 
operate correctly. When sound velocity measurements are not present 
(i.e., the port is reporting no data), use SECTION 7: TROUBLESHOOTING 
to go through the troubleshooting process. 
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Figure 6-4: Serial Port Information Window 

4. Click on Menu > File > Show Status. The System Status window will appear. 

5. At the bottom of the window, click the Config bullet, then the dropdown menu item named Config 

Item.  

6. Select Serial from the list. 

Check to make sure all sensors' usage percentages are well below 80%, as shown in FIGURE 6-5. 

 

Figure 6-5: Sensor Usage Percentage Check 
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7. If they are not, increase the baud rates of the sensors until these percentages drop. Make sure to 

change the baud rate accordingly in Sonar. 

8. When satisfied with the incoming data, press OK in the System Status window and close the Sonar 

- 192.9.0.101 - Remote Desktop Connection window. 
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7 .0  MAINTENANCE  

The 6205s2 Sonar Head is not designed for long-term deployments, and it is not recommended to keep 
the system in water for more than two weeks at a time, especially in warm, salty waters.  

After each mission, the system should be rinsed thoroughly with fresh water, making sure to rinse the 
SVS, which is mounted onto the connector nose cap, and connectors at the back.  

EdgeTech recommends regularly checking the array faces. Fouling and corrosion may degrade the 6205s2 
system's measurements and/or the sound velocity sensor at the bottom of the Sonar Head. If fouling is 
observed, clean the sonar head using a washcloth with mild soap and freshwater. The SVS, mounted onto 
the connector nose cap, should be regularly inspected, cleaned, and re-calibrated according to the 
manufacturer’s guidelines.  

Contact EDGETECH CUSTOMER SERVICE as soon as possible when any damage is observed. 

CAUTION! The 6205s2 system should NEVER be turned on and left 
powered on when the sonar head is not submerged in water because the 
unit will, in all likelihood, overheat, causing permanent damage (despite 
a basic protection system). In limited circumstances, the 6205s2 can be 
turned on but only with the Tx Power OFF (see Discover Bathymetric) to 
quickly test the system before deployment; however, this should never 
exceed a few minutes. Contact EDGETECH CUSTOMER SERVICE for further 
details 
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8.0  TROUBLESHOOTING 

8.1 Troubleshooting the SV Sensor 
In some cases, the sound velocity sensor may not start operating correctly. When this occurs, Discover 
Bathymetric will show a Port 4: Error on its Diagnostic Window, indicating that no sound velocity 
measurements are being reported to the sonar head. An example of this error is shown in FIGURE 8-1. 

 
Figure 8-1: No Sound Velocity on Port 4 

If this error persists longer than 30 seconds, follow the procedure below to resolve the issue: 

1. Place the Sonar Head in water, deep enough to submerge the SV probe (immerse the sonar head 

so that only the uppermost edge of the sonar head is exposed). This will submerge the sound 

velocity sensor as well. 

2. On the Windows Desktop, launch Remote Desktop to Sonar. The following window should 

appear: 

 
Figure 8-2: Sonar 192.9.0.101 Remote Desktop Connection Window 

3. Click on Menu > Misc > Serial Port Information. 

4. Check Chan 4 on Com 4 from the dropdown list to see if any data is being reported by port. 
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5. If no data is present, cycle the power on the sonar head using the On/Off switch on the Topside 

Interface unit. Allow the sonar to be off for at least 10 seconds before turning it back on. 

6. Once the sonar is reconnected, go back into the Remote Desktop application and check Chan 4 

on COM 4 again, as in step 4 above. 

7. If the port reports data, then proceed to normal operation. If not, continue to step 8. 

8. Closeout of Sonar.exe by clicking on the ‘X’ in the top right corner, as shown in FIGURE 8-3, red arrow. 

 
Figure 8-3: Closing the Sonar.exe Application  

9. Double-click the “EdgeTech Shortcut” and navigate to the Utilities/Teraterm folder. Launch 

ttermpro.exe. 

10. Select Serial, choose COM4 from the dropdown menu, as shown in FIGURE 8-4, and click OK. 

 

Figure 8-4: Connecting to COM4 using TeraTerm 
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11. Now, choose Setup from the top menu and then Serial port. 

12. Configure the serial port options as shown in FIGURE 8-5, and then click OK. 
 

 

Figure 8-5: COM4 Port Settings 

13. Input the following commands: 

Press <Enter> to start communications to SV sensor. 
Type in “SET STARTUP NOHEADER” and press <Enter>. 
Type in “SET SV FORMAT 42” and press <Enter>. 
Type in “SET SAMPLE 1/S” and press <Enter>. 
Type in “SET DETECT 06” and press <Enter>. 

14. Cycle the power on the Sonar Head using the On/Off switch on the interface box. Allow the sonar 

to be off for at least 10 seconds before turning it back on. 

15. Reconnect to the sonar via the Remote Desktop and check COM4 using the Sonar application as 

before in steps 3 and 4 above. SV data should not be scrolling as in: 
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Figure 8-6: Scrolling SV Data in Sonar.exe 

16. If SV data is still not present, contact EDGETECH CUSTOMER SERVICE with the noted information. 

8.2 Configuring Auxiliary Sensors for Redundant Information 
Auxiliary sensors can input redundant auxiliary information into the 6205s2. This will cause a significant 
data alignment problem as the sequential sonar data packets will be inconsistently stuffed from multiple 
sources. This section defines redundant auxiliary information as multiple sources of the same class of 
auxiliary information (e.g., roll, pitch, heading). This redundancy problem is generally caused by two 
sensors supplying the same message string and two sensors supplying the same information but from 
different messages. The following subsections describe each problem and the configuration that should 
be done to remedy it. In the event the auxiliary sensors cannot be reprogrammed to output select data 
messages, the Discover software should be configured so that only one specific source of information is 
used. 

8.2.1 Two Different Sensors Supplying the Same Message 
If two different sensors are outputting the same message (NMEA HDT, for example) and the sensors 
cannot be reprogrammed, then the Discover Bathymetric Software must be configured to accept the HDT 
information from one of the sensors only. To do so, use the procedure described below. 

NOTE: The configuration described below only works if there are two 
sensors outputting the same specific message (like HDT). It does not work 
for different messages that contain the same information (i.e., OCTANS 
and HDT). Refer to Scenario 7.3.2 in this case.  
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1. Open the Auxiliary Sensors control dialog box (Configuration menu > Auxiliary Sensors), as shown 

in FIGURE 8-7 and FIGURE 8-8. 

 
Figure 8-7: Configuration Menu 

 

Figure 8-8: Auxiliary Sensors 
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2. Specify what serial port to use for each particular input message. For example, in FIGURE 8-8, 

COM1 is used to feed GGA, VTG, and GGK, as shown in FIGURE 8-8, red box, to the 6205s2 Sonar 

Head, while COM 2 feeds in HDT, as shown in FIGURE 8-8, green box.  

3. When satisfied with the serial port setup, click on the X at the top right of the dialog box. 

4. Monitor Discover’s Lower Control Panel Main Status Line Display and Radio Indicator Tabs to 
ensure all supporting data is present. 

 

Figure 8-9: Sonar Control Tab 

NOTE: Refer to the DISCOVER BATHYMETRIC SOFTWARE MANUAL (PN 

0014878) for more information. 

8.2.2 Two Sensors Output Same Information with Different Messages 
Some motion sensors cannot turn off specific fields within their output strings. For example, a sensor that 
outputs an OCTANS message delivers roll, pitch, heading, and heave to the 6205s2 Sonar Head with no 
way for the particular sensor to turn off any of these specific fields. If a sensor like this is paired with 
another sensor that outputs the same information but in a different message format (i.e., NMEA HDT), 
redundant information is supplied to the system. This poses a problem and can lead to a significant 
alignment error in the 6205s2 data. 

To correct this, the 6205s2 can be programmed to ignore specific fields within one particular message. 
Use the example above and state the second heading sensor is preferred. Proceed to the following steps:  

1. Log in to Remote Desktop as outlined in sub-section 5.1. 

2. Double click on the folder labeled “Shortcut to EdgeTech Folder.” 

3. Navigate to the D:/EdgeTech/SSSSonarBathy/Sonar directory and open the SonarSerial.ini file. 

WARNING! Be careful in manipulating this file and only change what is 
stated in these directions. Changing any other field may cause sonar 
malfunction. 

https://www.edgetech.com/resource-center/
https://www.edgetech.com/resource-center/
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4. Find the serial port outputting the redundant message, and under the Parser field, add the words 

ParserParameters=DISABLEHEADING. For example, if COM 1 on the interface box is used to input 

an OCTANS message at a baud rate of 38400, then SonarSerial.ini should be manipulated to 

reflect, as shown in FIGURE 8-10. 

 
Figure 8-10: SonarSerial.ini 

NOTE: This new keyword disables the heading message from the OCTANS 
message. The same can be done with an EM1000 binary format message.  

Heading and heave are currently the only fields that can be 
enabled/disabled in the SonarSerial.ini file. 

To disable heave: ParserParameters=DISABLEHEAVE 

5. Save the file and exit. 

6. Power cycle the 6205s2 Sonar Head, allowing at least 15 seconds between switching off and on.  
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8.3  Configuring COM Ports 
There are three available COM ports on the Topside Interface Box to provide the necessary information 
to the 6205s2. This information includes position (latitude/longitude), heading, attitude (roll, pitch, and 
heave), and time. This appendix explains how to configure the three COM ports depending on the type of 
sensors used. 

NOTE: Most COM port configurations should be completed via the 
Discover Bathymetric Software. 

 

8.3.1 One Sensor 
One sensor, such as the Applanix PosMV, may be used to supply position (latitude/longitude), heading, 
attitude, and a time source. For this type of configuration, only COM1 will be utilized.  

To configure the COM ports for one sensor: 

1. Turn on Topside PC and connect the 6205s2 via the deck cable to the 6205s2 Topside Interface 
Box.  

2. Turn on the 6205s2 Sonar Head and run the Remote Desktop Application, named Sonar. The main 
screen, as shown in FIGURE 8-11, should appear. 

 

Figure 8-11: Sonar Remote Desktop Application, Main Screen 

Here, the user will see the Sonar Application running (designated by the blue arrow). Sonar.exe is 
the firmware that controls the system. 

3. Click on the 'X' at the top right to close the firmware. 

4. Double click on the Shortcut to EdgeTech icon and open the SSSonarBathy folder, then the Sonar 
folder. 

5. Look for the SonarSerial.ini file, as shown in FIGURE 8-12, and open it using WordPad or Notepad, 
as shown in FIGURE 8-13. 
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Figure 8-12: Finding the SonarSerial.ini File 

 

Figure 8-13: SonarSerial.ini File 

6. Under [Serial2] and [Serial3] set Create = 0, select File > Save, and close the file.  
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CAUTION! Do not alter the file in any way other than what has been 
specified. 

This will deactivate COM ports 2 and 3. By deactivating these ports, Sonar will report to Discover 
that only one sensor is to be used on COM1 to parse the necessary sensor information. Therefore, 
Discover will not display any errors if a sensor is not connected to COM2 or COM3. 

If steps 3 through 6 were not carried out, then these errors would be reported in the Diagnostic 
window, as shown in FIGURE 8-14. 

 
Figure 8-14: Diagnostic Window, Reporting Ports Inactive Error 

7. Close the SonarSerial.ini file and restart the Sonar application by double-clicking on the Sonar 
icon in the main Sonar Remote Desktop Screen, as shown in FIGURE 8-15

 

Figure 8-15: Sonar.Exe Desktop Location 

8. Plug the device into COM 1. 

9. Click Misc. at the top of the Sonar screen, as shown in FIGURE 8-16, then Serial Port Information. 

10. Check COM1 and set the correct baud rate for that device using the dropdown menu, shown with 
a blue arrow in FIGURE 8-16. When the correct baud rate is set, the State should say OK, and Errors 
should not be increasing, as shown circled in green in FIGURE 8-16. In addition, the correct data 
string should also be scrolling in the lower part of the window, as shown by the green arrow, 
FIGURE 8-16. 
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Figure 8-16: Checking Serial Port Information 

11. Click File > Show Status in the sonar window, as shown circled in red in FIGURE 8-17.  

 

Figure 8-17: Checking Sensor Status 
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Figure 8-18: Closing the System Status Window 

12. At the bottom of the window, make sure the item dropdown is Serial. Click the config button.  

13. Check to ensure the sensor's usage percentage is well below 80% (marked by a purple box).  

a. If it is not, increase the baud rate of the sensor. Change the baud rate under Serial Port 
Information, as shown in step 10. Check the Status again. Otherwise, the sonar will report 
errors.  

14. When satisfied with the incoming data, press OK in the System Status window, as shown in FIGURE 

8-18. 

15. Finally, close the Sonar - 192.9.0.101 - Remote Desktop Connection window.  

NOTE: If this window is left open during data acquisition, the user may 
experience a very slow computer. This is because the remote desktop 
application uses a large amount of the link capacity to stay open. So it is 
always a good idea to close the remote desktop application when finished 
with configurations. 
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8.3.2 Two Sensors 
Two sensors, such as a dual-headed GNSS (heading, position, and time source) and a motion reference 
unit (roll, pitch, and heave), may be used to supply the necessary information. For this type of 
configuration, only COM1 and COM2 will be used.  

To configure the COM ports for the two sensors: 

1. Follow steps 1 through 6, as stated in the, ONE SENSOR instructions. 

2. Under [Serial3], set Create = 0, select File > Save and close the file, as shown in FIGURE 8-20.  

CAUTION! Do not touch anything else, or the system’s configuration 
files could be seriously compromised, and functionality may suffer. 

This will deactivate COM3. By deactivating this port, Sonar will report to Discover that only two 

sensors are to be used on COM1 and COM 2 to parse the necessary sensor information. Therefore, 

Discover will not throw up any errors if a sensor is not connected to COM3. 

 

Figure 8-19: SonarSerial.ini File 

3. Reboot the Sonar Firmware by double-clicking on the Sonar icon in the main Sonar Remote 

Desktop Screen, as shown in FIGURE 8-15, designated by green arrow. 
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4. Now, plug in the devices into COM 1 and COM 2. Which device is connected to which COM port 

does not matter, as long as their respective ports and baud rates are set in Sonar. 

5. Click on Misc. at the top of the Sonar screen, as shown in FIGURE 8-16, then Serial Port 

Information. 

6. Check COM1 and set the correct baud rate for that device using the dropdown menu shown in 

blue, as shown in FIGURE 8-16. When the correct baud rate is set, the State should say OK, and 

Errors should not be increasing, as shown in FIGURE 8-16, circled in green. The correct data string 

should also be scrolling in the lower part of the window, as shown in FIGURE 8-16, green arrow. 

7. Now Check COM2 and set the correct baud rate for the other device as done before in Step 6. 

8. Now click on File > Show Status in the sonar window, as shown circled in red in FIGURE 8-17. 

9. On the right-hand side of the window, click on the Config bullet under the Update button and 

then on the dropdown menu named Config Item, as shown in FIGURE 8-18. 

10. Select Serial from the dropdown menu (green arrow), then click on the Update button (blue 

arrow) several times, as shown in FIGURE 8-18. 

11. Check to make sure sensors' usage percentages are well below 80%, as shown in FIGURE 8-20, 

circled in purple. If they are not, increase the sensor’s baud rate. Change baud rate under Serial 

Port Information as done in steps 6 and 7. Check Status again. Otherwise, sonar will report errors. 
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Figure 8-20: Checking Sensors’ Usages 

12. When satisfied with incoming data, press OK in the ‘System Status’ window, as shown in FIGURE 8-

20. 

13. Finally, close the Sonar - 192.9.0.101 - Remote Desktop Connection window.  

NOTE: If this window is left open during data acquisition, you may 
experience a very slow computer because the Remote Desktop uses a 
large amount of the link capacity to stay open. When finished with the 
configurations, it is wise to close the Remote Desktop. 

8.3.3 Three Sensors 
Three sensors, such as a gyro (heading), a GNSS (position and time source), and a Motion Reference Unit 
(roll, pitch, and heave), may be used to supply the necessary information. For this type of configuration, 
all available COM ports will be used.  

The following steps should be carried out to configure the COM ports for the three sensors. 
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1. Follow steps (1.) through (6.) as stated previously under appendix sub-section ONE SENSOR.  

2. Make sure Create=1 under each [Serial#], as shown in FIGURE 8-21. 

 
Figure 8-21: All Sensors Set 

3. Select File > Save and close the file.  

CAUTION! Do not touch anything else, or the system’s configuration 
files could be seriously compromised, and functionality may suffer. 

4. Close the SonarSerial.ini file and reboot the Sonar Firmware by double-clicking on the Sonar icon 

in the main Sonar Remote Desktop Screen, as shown in FIGURE 8-15, designated by the green 

arrow. 
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5. Now, plug in the devices into COM 1, COM 2, and COM 3. The Gyro should be connected to COM1, 

the MRU COM2, and the GPS to COM3. The devices connected to COM1 or COM2 may be 

interchanged, but the GPS must be connected to COM3.  

6. Click Misc. at the top of the Sonar screen, as shown in FIGURE 8-16, then Serial Port Information. 

7. Check COM1 and set the correct baud rate for that device using the dropdown menu shown in 

blue, as shown in FIGURE 8-16. When the correct baud rate is set, the State should say OK, and 

Errors should not be increasing, as shown in FIGURE 8-16, circled in green. The correct data string 

should also be scrolling in the lower part of the window, as shown in FIGURE 8-16, green arrow. 

8. Check COM2 and set the correct baud rate for the other device as done before in Step 6. 

a. Remember to check COM3 as before and set the correct baud rate for GPS. 

9. Click on File > Show Status in the sonar window, as shown in FIGURE 8-17, circled in red. 

10. On the right-hand side of the window, click on the Config bullet under the Update button and 

then on the dropdown menu named Config Item, as shown by the green arrow in FIGURE 8-18. 

11. Select Serial (green arrow), then click on the Update button several times (blue arrow) in FIGURE 

8-18. 

12. Check to make sure sensors' usage percentages are well below 80%, as shown in FIGURE 8-22, 

circled in purple. If they are not, increase the sensor’s baud rate. Change baud rate under Serial 

Port Information as done in steps 6 and 7. Check Status again; otherwise, sonar will report errors. 

13. When satisfied with incoming data, press OK in the ‘System Status’ window, as shown in FIGURE 8-

18. 

14. Finally, close the Sonar - 192.9.0.101 - Remote Desktop Connection window.  

NOTE: If this window is left open during data acquisition, the user may 
experience a very slow computer. This is because the remote desktop 
application uses a large amount of the link capacity to stay open. So it is 
always good to close the remote desktop application when finished with 
the configurations. 
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Figure 8-22: Checking all COM Ports 
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CAUTION! EdgeTech recommended performing the process described in 
the section below through Discover, but the process below provides an 
alternative. Please refer to the DISCOVER BATHYMETRY MANUAL for 
information on how to complete this process in Discover. 

8.3.4 UDP Connections 
The 6205s2 is compatible with data sent over the Ethernet connection via UDP. The SonarSerial.ini is 
utilized to configure the system to accept these messages. Note that 1PPS functionality must be utilized 
when operating with attitude / NAV being transferred with UDP messages.  

All messages detailed in SECTION 8.3 CONFIGURING COM PORTS Can also be sent to the 6205s2 over the 
Ethernet connection via UDP. EdgeTech does not recommend this method. The below example shows the 
same configuration detailed in FIGURE 8-23 but with UDP functionality.  

 

Figure 8-23: UDP Configuration Example 

 

https://www.edgetech.com/wp-content/uploads/2019/07/Discover-Bathy-Users_software-Manual_0014878_Rev_E.pdf
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CAUTION! EdgeTech recommended performing the process described in 
the section below through Discover, but the process below provides an 
alternative. Please refer to the DISCOVER BATHYMETRY MANUAL for 
information on how to complete this process in Discover. 

8.3.5 Applanix POS-MV Configuration 
 

 

Figure 8-24: Example Applanix POS-MV GNSS/INS Unit 

The 6205s2 is compatible with the POS-MV system from Applanix. Follow the below steps to configure 
the 6205s2 and the POS-MV for communication over the Ethernet interface via UDP.  

Utilizing the Applanix POSVIEW software: 

1. Set the ethernet real-time output data to groups 3,7,10, and 102. The output rate of the POSMV 
data should be set to 50Hz.  

2. The POS-MV must also be set to Falling (Negative) Edge or Active Low for the 1PPS as the 6205s2 
defaults to sync on the falling edge. 

3. Set the POS-MV Time Tag 1 to UTC. 

To configure the 6205s2 COM ports for the UDP messages from the POS-MV: 

1. Follow steps in UDP CONNECTIONS.  

2. Under [Serial1], [Serial2], and [Serial3] set Create = 0. 

https://www.edgetech.com/wp-content/uploads/2019/07/Discover-Bathy-Users_software-Manual_0014878_Rev_E.pdf
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3. Under [Serial5], set Create = 3 and remove the semicolon from the beginning of each line in the 

[Serial5] section. 

4. When the command Parserparameters=HEAVESCALE -1.0 is present in the [Serial5] section, add 

or ensure a semicolon at the beginning of the line to disable the command. When the command 

is not present, leave as is as the command is not required 

 
Figure 8-25: POSMV UDP Configuration 

CAUTION! Do not alter the file other than what has been specified. 

This will deactivate COM ports 1, 2, and 3 while activating COM 5, which has been pre-configured for 
POSMV functionality. Therefore, Discover will not throw up any errors if a sensor is not connected to 
COM1, COM2, or COM3.  

To review the time synchronization sources: 

1. Locate and open the SonarConfig.ini file. This file is located in the same directory as the 

SonarSerial.ini file modified above.  
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2. This file points the software to the correct configuration file based on the hardware's frequency 

set in use. Locate the [Main] section and take note of the .ini file being called out. As an example: 

the below file specifies the system is a 520kHz / 1600kHz Side Scan with 520kHz Bathymetry and, 

as such, utilizes the sonar_520B_1610.ini.  

 
Figure 8-26: SonarConfig.ini Example 

3. Close the SonarConfig.ini without making any changes to the text.  

4. Open the file name specified in the SonarConfig.ini. It is found in the same directory.  

5. Make sure the TimeSyncSource=POSMV_BINARY or it includes it in a list. Ensure there is no 

semicolon in front of this iteration of the keyword.   

 

Figure 8-27: TimeSyncSource POSMV_BINARY Keyword  

6. In the [DSP0] section of this file, ensure the OnePPSInputLine keyword is set to the following: 

OnePPSInputLine=2. Ensure there is no semicolon in front of the keyword.  

7. Select File > Save and close the text document. 

CAUTION! Do not alter the file other than what has been specified. 

This configuration sets the software to utilize the time and date reference received from the POS-MV data 
string. It also activates the 1PPS port on the topside module. Due to the inherent added latency, a 1PPS 
sync must be utilized when data is received via UDP.  
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When the above steps are complete, Sonar.exe must be re-launched to activate the configuration 
changes. This can be completed via the “x” in the top right-hand corner of the Sonar.exe GUI and the 
Sonar.exe shortcut on the embedded CPU desktop.  

Once the configuration of both the 6205s2 and the POS-MV is completed, the Sonar Serial Port Viewer 
can be utilized to confirm data is being accepted correctly. To access this, select the Misc. tab in the 
Sonar.exe GUI (as shown in FIGURE 8-16), then Serial Port Information. Next, select COM 5 in the first 
dropdown, ensure that data is received, and the State is reported as “OK.” 

Discover Bathymetry can also be used to check the correct configuration of the two units. The diagnostic 
window, as shown in FIGURE 8-14, should not report any errors. However, review all changes made in the 
above section if errors are seen. If errors persist, contact EDGETECH CUSTOMER SERVICE. 

8.3.6 SBG Ekinox/Apogee Configuration 

 

Figure 8-28: Example SBG Systems GNSS/INS unit 

 The 6205s2 is compatible with the Ekinox / Apogee systems from SBG Systems. Follow the below steps 
to configure the 6205s2 and the SBG for communication over the Ethernet interface via UDP. To configure: 

1. The sonar.exe file should be modified as shown below. 
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Figure 8-29: Ekinox/Apogee Sonar.ini file TimeSyncSource Keyword Adjustments 

2. The sonarserial.ini should be adjusted as shown below. 

 

Figure 8-30: Ekinox/Apogee SonarSerial.ini File Adjustment 

3. Access the SBG software using the instructions for the SBG user manual.  

NOTE: EdgeTech has assigned the IP address 192.9.0.51 to the OEM. 

4. Make the following required or suggested changes in the SBG Software UI (FIGURE 8-32) 
• Required: All selected outputs at the same rate. The Hydro-Hypack preset selection is 

recommended to enable the necessary data messages at a suitable output rate. 
• Required: EKF Euler (Provides Pitch, Roll, Heading) 
• Required: EKF Nav (for Ekinox or Apogee if you want Edgetech GGK and VTG generated) 
• Required: UTC Time 
• Recommended: Ship Motion 0 (Provides Heave) 
• Optional: Inertial Data (Provides Accelerometers) 

5. NMEA Configuration 
• NMEA messages can also be accepted.  
• Parser selection is done in Discover Bathymetric software. 
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Figure 8-31: UDP broadcast settings example 

 

 

 

Figure 8-32: Data packets required, set using the recommended SBG's "Hydro-Hypack” 
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Figure 8-33: 1PPS settings example, Falling Edge and 1msec duration 

 

8.3.7 OEM Integrated SBG Ekinox Configuration 

   

Figure 8-34: SBG Systems OEM GNSS and INS units 
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The 6205s2 is compatible with an OEM Integrated SBG Ekinox system.  Edgetech does integrate and 
configure the systems when purchased. The only configurations required of the customer are setting lever 
arm and GNSS antenna positions in the SBG software, which are unique to each host platform.  

8.3.7.1 Lever Arm and GNSS Antenna Position Configuration 

6. Access the SBG software using the instructions for the SBG user manual.  

NOTE: EdgeTech has assigned the IP address 192.9.0.51 to the OEM. 

7. Select Sensor on the left menu and the Lever Arms Tab at the top of the SBG Window. The Sensor 
Lever Arms Primary Lever Arm Center of Rotation Level Arm (X,Y,Z) meter values should be 
populated. These are the offsets from the IMU to the center of the vessel.  

CAUTION! Do not change any Monitoring Points values unless you’re sure 
they should be changed. EdgeTech has set a Monitoring Point that is valid 
for the Ethernet data output to be the Sonar Acoustic Center, so only 
change these values when you do not wish for this and instead wish for 
the SBG data to be valid at an alternative location. 

 
Figure 8-35: Sensor Lever Arms Primary Lever Arm Values 

8. Next, select the Aiding Settings Menu Item on the left and then the GPS1 Tab at the top. The GNSS 
Lever Arms Primary and Secondary Antenna (X,Y,Z) meter values should be entered. These are 
the offsets from the antennas to the IMU. No other Aiding Setting values should be changed.  

DO NOT CHANGE MONITORING POINTS 
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Figure 8-36: Aiding Setting GPS1 GNSS Lever Arm Values 

Additional configurations are possible. Please see the SBG instruction manual for detailed information on 
settings and additional options. The following settings are required or suggested to configure the 6205s2 
and the SBG for communication over the Ethernet interface via UDP.  

EdgeTech preconfigures the sensor for the Hydro – Hypack preset output at 40 Hz.  We do not 
recommend changing this setting.  However, the following should be kept in mind if a change is 
unavoidable: 

• Binary 
o Required: All selected outputs at the same rate, recommended 50Hz 
o Required: EKF Euler (Provides Pitch, Roll, Heading) 
o Required: EKF Nav (for Ekinox or Apogee if you want Edgetech GGK and VTG 

generated) 
o Required: UTC Time 
o Recommended: Ship Motion 0 (Provides Heave) 
o Optional: Inertial Data (Provides Accelerometers) 

• NMEA 
o Required Messages: HDT, TSS1, GGA, VTG, ZDA 
o A change of message type may require a parser adjustment.  This can be 

accomplished in Discover Bathymetric Software. 

8.4 Computer System Restoration 
The following section outlines the procedures for backing up and restoring the system drive. EdgeTech 
currently uses Macrium Reflect as system restoration software. 

CAUTION! All data will be lost upon restoring the system to factory 
settings. Therefore, be sure to back up all data before performing the 
procedure below. 
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NOTE: A mouse may be needed to operate the Macrium Reflect UI. 

Macrium Reflect Instructions 

1. Before Powering on the topside, insert the USB3 flash drive into a blue USB3 port. 

2. Power on the topside and press the F** key. F** will be different depending on what 

you are booting. 

a. If the Topside is a rack mount, Press F11. 

b. If the Topside is a laptop, Press F10. 

3. Under the Boot Manager. Use the up/down arrows to select the flash drive Corsair 

Voyager 3.0. 

4. Wait for Macrium Reflect to boot, and then select the Existing Backup tabs.  

5. Under the Image tab, select Edit

 

Figure 8-37: Restoration Edit Image Selection 

6. Browse for the backup folder located on the 0020475_Rev_” drive. The folder should 

have the following format XXXX_SNSSSSS. Once the folder has been selected, click 

OK and then OK. 



   8-79 

  
   

 

Figure 8-38: Restoration- Add Search Path Confirmation Buttons 

7. You should now see that the restore file has been populated in the window. Next, 

click on Restore. 

 

Figure 8-39: Restoration Restore Button 

8. On the next window, Select Next, followed by Finish.  



8-80       

 
6205s2 BATHYMETRIC AND SIDE SCAN SONAR 0025262_REV_A 

9. A window will open, warning you that everything will be overwritten. Click on the 

Check Box to approve and then click Continue on this window.  

 

Figure 8-40: Restoration-Confirm Overwrite Continue Button 

10. The restoring process should take 2-4 minutes to complete. Once it is finished, click 

the red button on the bottom left of the screen  and select Shutdown, and then 

Okay. 

11. Remove the USB3 flash drive and turn the power to the topside back on to verify the 

image has been restored successfully. 
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9 .0  KITS 

EdgeTech offers spare, tool, and option kits to upgrade and maintain your 6205s2 system components. 
Please contact EDGETECH CUSTOMER SERVICE before any repair to maintain the warranty and receive the 
most up-to-date kit and instructions. 

9.1 Spare Kits 
PN# KIT DESCRIPTION 

0024484 ASSY TOP KIT SPARES 6205S2 TOPSIDE RACK MOUNT 

0024485 ASSY TOP KIT SPARES 6205S2 ELECTRONICS 520 / 1600 KHZ SIDESCAN / 520 KHZ BATHY 

0024486 ASSY TOP KIT SPARES 6502S2 ELECTRONICS 520 / 850 KHZ SIDESCAN / 520 KHZ BATHY 

0024487 ASSY TOP KIT SPARES 6502S2 ELECTRONICS 520 / 850 KHZ SIDESCAN / 850 KHZ BATHY 

0024488 ASSY TOP KIT SPARES 6502S2 ELECTRONICS 850 / 1600 KHZ SIDESCAN / 850 KHZ BATHY 

Table 9-1: 6205s2 Topside and Sonar Head Spare Kits 

9.2 Tool Kit 
PN# KIT DESCRIPTION 

0024448 ASSY TOP KIT 6205S2 SYSTEM TOOLS 

Table 9-2: 6205s2 Tool Kit 

9.3 Adaptor Flange Installation Kit 
EdgeTech offers an Adaptor Flange Kit that includes a high-quality flange and necessary hardware to 
mount the 6205s2 to a customer’s manufactured pole. 

 

PN# KIT DESCRIPTION 

0024489 ASSY TOP KIT 6205S2 ADAPTOR FLANGE 

Table 9-3: 6205S2 Adaptor Flange Installation Kit 

Tools: 

• 3/8” T-Handle Ball-Point Hey Key 
• Adjustable Crescent Wrench 
• 5/8” Socket Wrench 
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Instructions: 

The Adaptor flange plate is attached to the 6205s2 by threading the [3] 5/8” hex screw hardware 
assemblies. EdgeTech suggests coating with a liquid thread locker such as Loctite®. The Adaptor Flange 
is connected to a customer’s pole mounting by threading [6] .625 bolt, split-lock washer, washer, and 
nut assemblies. 

 
Figure 9-1: 6205s2 Adaptor Flange Installation 

9.4 Sensor SBG IMU and GNSS Installation Kit 
PN# KIT DESCRIPTION 

0024541 ASSY TOP KIT 6205S2 SENSOR SBG IMU & GNSS 

Table 9-4: SBG IMU and GNSS Integration Kit 
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A .0  COMPATIBLE  SOFTWARE 

A.1 Discover Bathymetric 
EdgeTech’s  Discover Bathymetric Software provides a way to control, store, and display Bathymetric and 
Dual-Frequency Side Scan Sonar data. Data is presented in a color waterfall display and stored in the binary 
EdgeTech JSF file format on the hard disk of the topside processor. The JSF file format has been in use for 
10+ years and has new public extensions to support the additional Bathymetry data messages. Refer to 
the DISCOVER BATHYMETRIC USERS SOFTWARE MANUAL (0014678) for detailed information on the software. 

A.2 Third-Party Software 
There are several third-party software packages that EdgeTech has approved to use with the 6205s2 
System, and work continues to expand the number of available 3rd party software packages. A brief 
description is listed below. For the latest list of 3rd party software packages, contact EDGETECH CUSTOMER 

SERVICE. 

A.2.1 HYPACK 
The bathymetry and side-scan data are sent in real-time to the HYPACK®/HYSWEEP® survey applications. 
These applications display and record the bathymetric data in HYPACK’s HSX format. These HSX files can 
then be used offline in the MBMax, Side Scan Mosaic, and other proprietary packages that support these 
formats to edit, clean, and mosaic the collected data. 

For more information on Hypack, visit: HTTP://WWW.HYPACK.COM/NEW/ 

A.2.2 SonarWiz 
SonarWiz from Chesapeake Technologies Inc. is an all-in-one suite of programs for the real-time 
acquisition of sonar data. The latest version of SonarWiz, called SonarWiz 7, now offers a bathymetry 
module to acquire and post-process the real-time 6205s2 Swath Bathymetry and Dual Frequency Side 
Scan data. In addition, the latest release also can ingest the native EdgeTech JSF files post-survey to post-
process the sonar data files recorded by Discover Bathymetric.  

For more information on SonarWiz, visit: HTTPS://CHESAPEAKETECH.COM/  

https://www.edgetech.com/resource-center/
http://www.hypack.com/new/
https://chesapeaketech.com/
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A.2.3 Qinsy 
Qinsy is a hydrographic data acquisition, navigation, and processing software package. The suite of 
applications can be used for various types of surveys, ranging from simple single beam surveys up to 
complex offshore construction works.  

For more information on Qinsy, visit: HTTP://WWW.QPS.NL/DISPLAY/QINSY/MAIN 

A.2.4 CARIS 
CARIS HIPS and SIPS is a comprehensive Bathymetric, seafloor imagery, and water column data-processing 
software. The HIPS and SIPS software enables the user to simultaneously process multibeam, backscatter, 
side-scan sonar, LiDAR, and single beam data. In addition, its data importer supports EdgeTech’s 
bathymetry and side-scan data formats. 

For more information on CARIS, visit: HTTP://WWW.CARIS.COM/ 

A.2.5 EIVA NaviSuite 
EIVA’s NaviSuite constitutes a complete, advanced, multipurpose suite of software products for virtually 
any subsea sonar and sensor survey or engineering operation. NaviSuite covers the entire data workflow 
in a continuous, non-sequential process from online data acquisition to offline post-processing.  

For more information on EIVA NaviSuite, visit: HTTP://WWW.EIVA.COM/PRODUCTS/SOFTWARE 

A.2.6 BEAMWORX Suite 
Beamworx’s suite constitutes a multipurpose suite of software products for multibeam operations. From 
online data acquisition (NavAq) to offline post-processing (AutoClean) and also automated Patch Test 
(AutoPatch), the suite is fast and friendly. 

For more information on Beamworx, visit: HTTP://WWW.BEAMWORX.COM 

http://www.qps.nl/display/qinsy/main
http://www.caris.com/
http://www.eiva.com/products/software
http://www.beamworx.com/
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NOTES:


WEIGHT ESTIMATE:1.
IN AIR: ~2.5 LBF [~1.1 KG]
IN WATER: ~0.9 LBF [~0.4 KG]


*WEIGHTS ARE APPROXIMATED AND WILL BE CONFIRMED AFTER FIRST ARTICLE BUILD.


DEPTH RATING: 2000M2.


TRANSDUCER MATERIALS:3.
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FREQUENCY OPTIONS:4.
520kHz / 850kHz SIDE SCAN - 520kHz BATHY
520kHz / 1600kHz SIDE SCAN - 520kHz BATHY
520kHz / 850kHz SIDE SCAN -850kHz BATHY
850kHz / 1600kHz SIDE SCAN - 850kHz BATHY


DIMENSIONS IN [BRACKETS] ARE IN MM.   5.


6      PENETRATOR TO PLATFORM SEAL DESIGN SPECIFICATION (SEE DETAIL B):
THE O-RING GLAND IS SIZED PER THE PARKER O-RING HANDBOOK•
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DETAIL A
SCALE 1 : 2


CL


CL


NOTES:


WEIGHTS:1.
IN AIR: 40 LBF [18.1 KG]
IN WATER: 13.1 LBF [5.9 KG]


2.     FREQUENCY OPTIONS:
520KHZ / 850KHZ SIDE SCAN - 520KHZ BATHY
520KHZ / 1600KHZ SIDE SCAN - 520KHZ BATHY
520KHZ / 850KHZ SIDE SCAN - 850KHZ BATHY
850KHZ / 1600KHZ SIDE SCAN - 850KHZ BATHY


3.     DIMENSIONS IN [BRACKETS] ARE IN MM.


4    SBG EKINOX DATA OUTPUT SET FOR ACOUSTIC CENTER.
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NOTES:
1 DIMENSIONS IN [BRACKETS] ARE IN MILLIMETERS


2 TOTAL WEIGHT: 23.8 LB [10.8 KG]


RACKMOUNT WEIGHT: 13.0 LB [5.9 KG]


CASE WEIGHT: 10.8 LB [4.9 KG]


3 MATERIALS:  


RACKMOUNT: ALUMINUM 


SKB CASE: ROTO-MOLDED
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